Instructions for Authors

GENERAL
The Journal of the Serbian Chemical Society (the Journal in further text) is an international journal publishing papers from all fields of chemistry and related disciplines. Twelve issues are published annually. The Editorial Board expects the editors, reviewers and authors to respect the well-known standard of professional ethics.

TYPES OF CONTRIBUTIONS

Original scientific papers (up to 15 typewritten pages, including Figures, Tables and References) report original research which must not have been previously published.

Short communications (up to 8 pages) report unpublished preliminary results of sufficient importance to merit rapid publication.

Notes (up to 5 pages) report unpublished results of short, but complete, original research.

Authors' reviews (up to 40 pages) present an overview of the author’s current research with comparison to data of other scientists working in the field.

Reviews* (up to 40 pages) present a concise and critical survey of a specific research area. Generally, these are prepared at the invitation of the Editor.

Surveys (up to 25 pages) communicate a short review of a specific research area.

Book and Web site reviews (1 - 2 pages)

Extended abstracts (about 4 pages) of Lectures given at meetings of the Serbian Chemical Society Divisions.

Letters to the Editor report miscellaneous topics directed directly to the Editor.

*Generally, Authors’ reviews, Reviews and Surveys are prepared at the invitation of the Editor.

The preparation of the manuscript with the use of JSCS template is strictly recommended.

DOWNLOAD JSCS TEMPLATE!

SUBMISSION OF MANUSCRIPTS

Manuscripts should be submitted using the Online Submission Form, available on the JSCS Web Site (http://www.shd-pub.org.rs/index.php/JSCS). The manuscript must be uploaded as a Word.doc or .rtf file, with tables and figures (including the corresponding captions - above Tables and below Figures), placed within the text to follow the paragraph in which they were mentioned for the first time.

Please note that Full Names (First Name, Last Name), Full Affiliation and Country (from drop down menu) of ALL OF AUTHORS (written in accordance with English spelling rules - the first letter capitalized) must be entered in the manuscript Submission Form (Step 3). Manuscript Title, authors’ names and affiliations, as well as the Abstract, WILL APPEAR in the article listing, as well as in BIBLIOGRAPHIC DATABASES (WoS, SCOPUS...), in the form and in the order entered in the author details.

Graphical abstract

Graphical abstract is a one-image file containing the main depiction of the authors work and/or conclusion and must be supplied along with the manuscript. It must enable readers to quickly gain the main message of the paper and to encourage browsing, help readers identify which papers are most relevant to their research interests. Authors must provide an image that clearly represents the research described in the paper. The most relevant figure from the work, which summarizes the content, can also be submitted. The image should be submitted as a separate file in Online Submission Form - Step 2.

Specifications: The graphical abstract should have a clear start and end, reading from top to bottom or left to right. Please omit unnecessary distractions as much as possible.

- **Image size:** minimum of 500×800 pixels (W×H) and a minimum resolution of 300 dpi. If a larger image is sent, then please use the same ratio: 16 wide × 9 high. Please note that your image will be scaled proportionally to fit in the available window in TOC; a 150x240 pixel rectangle. Please be sure that the quality of an image cannot be increased by changing the resolution from lower to higher, but only by rescanning or exporting the image with a higher resolution, which can be set in usual "settings" option.

- **Font:** Please use Calibri and Symbol font with a large enough font size, so it is readable even from the image of a smaller size (150 × 240 px) in TOC.

- **File type:** JPG and PNG only.

No additional text, outline or synopsis should be included. Please do not use white space or any heading within the image.
Cover Letter
Manuscripts must be accompanied by a cover letter (strictly uploaded in Online Submission Step 2) in which the type of the submitted manuscript and a warranty as given below are given. The Author(s) has(have) to warranty that the manuscript submitted to the Journal for review is original, has been written by the stated author(s) and has not been published elsewhere; is currently not being considered for publication by any other journal and will not be submitted for such a review while under review by the Journal; the manuscript contains no libellous or other unlawful statements and does not contain any materials that violate any personal or proprietary rights of any other person or entity. All manuscripts will be acknowledged on receipt (by e-mail).

Illustrations (Figs, schemes, photos...) in TIF or EPS format (JPG format is acceptable for colour and greyscale photos, only), must be additionally uploaded (Online Submissions Step 2) as a separate files or one archived (.zip, .rar or .arj) file. Figures and/or Schemes should be prepared according to the Artwork Instructions!

For any difficulties and questions related to Online Submission Form, please refer to User Guide, Chapter Submitting an Article. If difficulties still persist, please contact JCS Editorial Office at JCS@shd.org.rs

If the manuscript is not fully prepared in accordance with this Author Guidelines, will be returned to corrections as UNSUITABLE SUBMISSION, and must be resubmitted as a new manuscript!!!

Conflict-of-Interest Statement*:
Public trust in the peer review process and the credibility of published articles depend in part on how well a conflict of interest is handled during writing, peer review, and editorial decision making. A conflict of interest exists when an author (or the author's institution), reviewer, or editor has financial or personal relationships that inappropriately influence (bias) his or her actions (such relationships are also known as dual commitments, competing interests, or competing loyalties). These relationships vary from those with negligible potential to those with great potential to influence judgment, and not all relationships represent true conflict of interest. The potential for a conflict of interest can exist whether or not an individual believes that the relationship affects his or her scientific judgment. Financial relationships (such as employment, consultancies, stock ownership, honoraria, paid expert testimony) are the most easily identifiable conflicts of interest and the most likely to undermine the credibility of the journal, the authors, and of science itself. However, conflicts can occur for other reasons, such as personal relationships, academic competition, and intellectual passion.

Informed Consent Statement*:
Patients have a right to privacy that should not be infringed without informed consent. Identifying information, including patients’ names, initials, or hospital numbers, should not be published in written descriptions, photographs, and pedigrees unless the information is essential for scientific purposes and the patient (or parent or guardian) gives written informed consent for publication. Informed consent for this purpose requires that a patient who is identifiable be shown the manuscript to be published. Authors should identify individuals who provide writing assistance and disclose the funding source for this assistance. Identifying details should be omitted if they are not essential. Complete anonymity is difficult to achieve, however, and informed consent should be obtained if there is any doubt. For example, masking the eye region in photographs of patients is inadequate protection of anonymity. If identifying characteristics are altered to protect anonymity, such as in genetic pedigrees, authors should provide assurance that alterations do not distort scientific meaning and editors should so note. The requirement for informed consent should be included in the journal's instructions for authors. When informed consent has been obtained it should be indicated in the published article.

Human and Animal Rights Statement*:
When reporting experiments on human subjects, authors should indicate whether the procedures followed were in accordance with the ethical standards of the responsible committee on human experimentation (institutional and national) and with the Helsinki Declaration of 1975, as revised in 2000 (5). If doubt exists whether the research was conducted in accordance with the Helsinki Declaration, the authors must explain the rationale for their approach, and demonstrate that the institutional review body explicitly approved the doubtful aspects of the study. When reporting experiments on animals, authors should be asked to indicate whether the institutional and national guide for the care and use of laboratory animals was followed.

* International Committee of Medical Journal Editors ("Uniform Requirements for Manuscripts Submitted to Biomedical Journals") -- February 2006
PROCEDURE
All contributions will be peer reviewed and only those deemed worthy and suitable will be accepted for publication. The Editor has the final decision. To facilitate the reviewing process, authors are encouraged to suggest up to three persons competent to review their manuscript. Such suggestions will be taken into consideration but not always accepted. If authors would prefer a specific person not be a reviewer, this should be announced. The Cover Letter must be accompanied by these suggestions. Manuscripts requiring revision should be returned according to the requirement of the Editor, within 60 days upon reception of the reviewing comments by e-mail.

The *Journal* maintains its policy and takes the liberty of correcting the English as well as false content of manuscripts provisionally accepted for publication in the first stage of reviewing process. In this second stage of manuscript preparation by JSCS Editorial Office, the author(s) may be required to supply some additional clarifications and corrections. This procedure will be executed during copyediting actions, with a demand to author(s) to perform corrections of unclear parts before the manuscript would be published OnLine as finally accepted manuscript (OnLine First Section of the JSCS website). Please note that the manuscript can receive the status of final rejection if the author’s corrections would not be satisfactory.

When finally accepted manuscript is ready for printing, the corresponding author will receive a request for proof reading, which should be performed within 2 days. Failure to do so will be taken as the authors are in agreement with any alteration which may have occurred during the preparation of the manuscript for printing.

Accepted manuscripts of active members of the Serbian Chemical Society (all authors) have publishing priority.

MANUSCRIPT PRESENTATION
Manuscripts should be typed in English (either standard British or American English, but consistent throughout) with 1.5 spacing (12 points Times New Roman; Greek letters in the character font Symbol) in A4 format leaving 2.5 cm for margins. For Regional specific, non-standard characters that may appear in the text, save documents with Embed fonts Word option: Save as -> (Tools) -> Save Options... -> Embed fonts in the text.

The authors are requested to seek the assistance of competent English language expert, if necessary, to ensure their English is of a reasonable standard. The Serbian Chemical Society can provide this service in advance of submission of the manuscript. If this service is required, please contact the office of the Society by e-mail (jscs-info@shd.org.rs).

**Tables, figures and/or schemes** must be embedded in the main text of the manuscript and should follow the paragraph in which they are mentioned for the first time. **Tables** must be prepared with the aid of the WORD table function, without vertical lines. The minimum size of the font in the tables should be 10 pt. Table columns must not be formatted using multiple spaces. Table rows must not be formatted using any returns (enter key; ↓ key) and are limited to 12 cm length. Tables should not be incorporated as graphical objects. **Footnotes to Tables** should follow them and are to be indicated consequently (in a single line) in superscript letters and separated by semi-column.

**Table caption** must be placed above corresponding Table, while **Captions of the Illustrations** (Figs. Schemes...) must follow the corresponding item. **The captions, either for Tables or Illustrations**, should make the items comprehensible without reading of the main text (but clearly referenced in), must follow numerical order (Roman for Tables, Arabic for Illustrations), and should not be provided on separate sheets or as separate files.

**High resolution Illustrations** (named as Fig. 1, Fig. 2... and/or Scheme 1, Scheme 2...) in **TIF or EPS format** (JPG format is acceptable for photos, only) must be additionally uploaded (Online Submissions Step 4) as a separate files or one archived (.zip, .rar) file.

**Illustrations** should be prepared according to the ARTWORK INSTRUCTIONS!

All pages of the manuscript must be numbered continuously.

DESIGNATION OF PHYSICAL QUANTITIES AND UNITS
**IUPAC recommendations** for the naming of compounds should be followed. SI units, or other permissible units, should be employed. The designation of physical quantities must be in italic throughout the text (including figures, tables and equations), whereas the units and indexes (except for indexes having the meaning of physical quantities) are in upright letters. They should be in Times New Roman font. In graphs and tables, a slash should be used to separate the designation of a physical quantity from the unit (example: $p / \text{kPa}$, $j / \text{mA cm}^2$, $t / ^\circ\text{C}$, $T_0 / \text{K}$, $\tau / \text{h}$, $\ln (j / \text{mA cm}^2)$...). Designations such as: $p \text{(kPa)}$, $t \text{[min]}$, $\text{are not acceptable. However, if the full name of a physical quantity is unavoidable, it should be given in upright letters and separated from the unit by a comma}$ (example: Pressure, kPa; Temperature, K; Current density, mA cm$^2$...). Please do not use the axes of graphs for additional explanations; these should be mentioned in the figure captions and/or the manuscript (example: “pressure at the inlet of the system, kPa” should be avoided). The axis name should follow the direction of the axis (the name of y-axis should be rotated by 90°). Top and right axes should be avoided in diagrams, unless they are absolutely necessary.
Latin words, as well as the names of species, should be in italic, as for example: i.e., e.g., in vivo, ibid, Calendula officinalis L., etc. The branching of organic compound should also be indicated in italic, for example, n-butanol, tert-butanol, etc. Decimal numbers must have decimal points and not commas in the text (except in the Serbian abstract), tables and axis labels in graphical presentations of results. Thousands are separated, if at all, by a comma and not a point. Mathematical and chemical equations should be given in separate lines and must be numbered, Arabic numbers, consecutively in parenthesis at the end of the line. All equations should be embedded in the text Complex equations (fractions, integrals, matrix...) should be prepared with the aid of the Microsoft Equation 3.0 (or higher) or MathType (Do not use them to create simple equations and labels). Using the Insert -> Equation option, integrated in MS Office 2010 and MS Office 2013, as well as insertion of equation objects within paragraph text IS NOT ALLOWED.

ARTICLE STRUCTURE
• TITLE PAGE
• MAIN TEXT - including Tables and Illustrations with corresponding captions
• SUPPLEMENTARY MATERIAL (optional)

Title page - Title in bold letters, should be clear and concise, preferably 12 words or less. The use of non-standard abbreviations, symbols and formulae is discouraged.

AUTHORS’ NAMES in capital letters with the full first name, initials of further names separated by a space and surname. Commas should separate the author’s names except for the last two names when ‘and’ is to be used. In multi-affiliation manuscripts, the author’s affiliation should be indicated by an Arabic number placed in superscript after the name and before the affiliation. Use * to denote the corresponding author(s).

Affiliations should be written in italic. The e-mail address of the corresponding author should be given after the affiliation(s).

Abstract: A one-paragraph abstract written of 150 – 200 words in an impersonal form indicating the aims of the work, the main results and conclusions should be given and clearly set off from the text. Domestic authors should also submit, on a separate page, an Abstract - Izvod, the author’s name(s) and affiliation(s) in Serbian (Cyrillic letters). (Домаћи аутори морају доставити Извод (укључујући имена аутора и афилијацију) на српском језику, исписане ћирилицом, иза Захвалнице, а пре списака референци.) For authors outside Serbia, the Editorial Board will provide a Serbian translation of their English abstract.

Keywords: Up to 6 keywords should be given. Do not use words appearing in the manuscript title

RUNNING TITLE: A one line (maximum five words) short title in capital letters should be provided.

Main text - should have the form:
INTRODUCTION,
EXPERIMENTAL (RESULTS AND DISCUSSION)
RESULTS AND DISCUSSION (EXPERIMENTAL)
CONCLUSIONS
NOMENCLATURE (optional)
Acknowledgements: If any.
REFERENCES (Citation of recent papers published in chemistry journals that highlight the significance of work to the general readership is encouraged.)
The sections should be arranged in a sequence generally accepted for publication in the respective fields. They subtitles should be in capital letters, centred and NOT numbered.

The **INTRODUCTION** should include the aim of the research and a concise description of background information and related studies directly connected to the paper.

The **EXPERIMENTAL** section should give the purity and source of all employed materials, as well as details of the instruments used. The employed methods should be described in sufficient detail to enable experienced persons to repeat them. Standard procedures should be referenced and only modifications described in detail.

On no account should results be included in the experimental section.

**Chemistry**

Detailed informations about instruments and general experimental techniques should be given in all necessary details. If special treatment for solvents or chemical purification were applied that must be emphasized.

**Example:** Melting points were determined on a Boetius PMHK or a Mel-Temp apparatus and were not corrected. Optical rotations were measured on a Rudolph Research Analytical automatic polarimeter, Autopol IV in dichloromethane (DCM) or methanol (MeOH) as solvent. IR spectra were recorded on a Perkin-Elmer spectrophotometer FT-IR 1725X. $^1$H and $^{13}$C NMR spectra were recorded on a Varian Gemini-200 spectrometer (at 200 and 50 MHz, respectively), and on a Bruker Ultrashield Advance III spectrometer (at 500 and 125 MHz, respectively) employing indicated solvents (**vide infra**) using TMS as the internal standard. Chemical shifts are expressed in ppm ($\delta$ / ppm) values and coupling constants in Hz ( / Hz). ESI-MS spectra were recorded on Agilent Technologies 6210 Time-Of-Flight LC-MS instrument in positive ion mode with CH$_3$CN/H$_2$O 1/1 with 0.2 % HCOOH as the carrying solvent solution. Samples were dissolved in CH$_3$CN or MeOH (HPLC grade purity). The selected values were as follows: capillary voltage = 4 kV, gas temperature = 350 °C, drying gas flow 12 L min$^{-1}$, nebulizer pressure = 310 kPa, fragmentator voltage = 70 V. The elemental analysis was performed on the Vario EL III- C,H,N,S/O Elemental Analyzer (Elementar Analysensysteme GmbH, Hanau-Germany). Thin-layer chromatography (TLC) was performed on precoated Merck silica gel 60 F254 and RP-18 F254 plates. Column chromatography was performed on Lobar LichroPrep Si 60 (40-63 µm), RP-18 (40-63 µm) columns coupled to a Waters RI 401 detector, and on Biotage SP1 system with UV detector and FLASH 12+, FLASH 25+ or FLASH 40+ columns pre packed with KP-SIL [40-63 µm, pore diameter 6 nm (60 Å)], KP-C18-HS (40-63 µm, pore diameter 9 nm (90 Å) or KP-NH [40-63 µm, pore diameter 10 nm (100 Å)] as adsorbent. Compounds were analyzed for purity (HPLC) using a Waters 1525 HPLC dual pump system equipped with an Alttech, Select degasser system, and dual λ 2487 UV-VIS detector. For data processing, Empower software was used (methods A and B). Methods C and D: Agilent Technologies 1260 Liquid Chromatograph equipped with Quat Pump (G1311B), Injector (G1329B) 1260 ALS, TCC 1260 (G1316A) and Detector 1260 DAD VL+ (G1315C). For data processing, LC OpenLab CDS ChemStation software was used. For details, see Supporting Information.

1. **Synthesis experiments**

Each paragraph describing a synthesis experiment should begin with the name of the product and any structure number assigned to the compound in the Results and Discussions section. Thereafter, the compound should be identified by its structure number. Use of standard abbreviations or unambiguous molecular formulas for reagents and solvents, and of structure numbers rather than chemical names to identify starting materials and intermediates, is encouraged.

When a new or improved synthetic method is described, the yields reported in key experimental examples, and yields used for comparison with existing methods, should represent amounts of isolated and purified products, rather than chromatographically or spectroscopically determined yields. Reactant quantities should be reported in weight and molar units and for product yields should be reported in weight units; percentage yields should only be reported for materials of demonstrated purity. When chromatography is used for product purification, both the support and solvent should be identified.

2. **Microwave experiments**

Reports of syntheses conducted in microwave reactors must clearly indicate whether sealed or open reaction vessels were used and must document the manufacturer and model of the reactor, the method of monitoring the reaction mixture temperature, and the temperature-time profile. Reporting a wattage rating or power setting is not an acceptable alternative to providing temperature data. Manuscripts describing work done with domestic (kitchen) microwave ovens will not be accepted except for studies where the unit is used for heating reaction mixtures at atmospheric pressure.

3. **Compound characterization**

The Journal upholds a high standard for compound characterization to ensure that substances being added to the chemical literature have been correctly identified and can be synthesized in known yield and purity by the reported preparation and isolation methods. For **all new** compounds, evidence adequate to establish both identity and degree of purity (homogeneity) must be provided.
Identity

Melting point. All homogeneous solid products (e.g. not mixtures of isomers) should be characterized by melting or decomposition points. The colors and morphologies of the products should also be noted.

Specific rotations. Specific rotations based on the equation $[\alpha]_D = \frac{100 \alpha}{(l \cdot c)}$ should be reported as unitless numbers as in the following example: $[\alpha]^{20}_D = -25.4 \, (c \, 1.93, \text{CHCl}_3)$, where $c$ is concentration and $l$ is path length. The units of the specific rotation, $(\text{deg} \, \text{cm}^{-1})$, are implicit and are not included with the reported value.

Spectra/Spectral Data. Important IR adsorptions should be given. For all new diamagnetic substances, NMR data should be reported ($^1\text{H}$, $^{13}\text{C}$, and relevant heteronuclei). $^1\text{H}$ NMR chemical shifts should be given with two digits after the decimal point. Include the number of protons represented by the signal, signal multiplicity, and coupling constants as needed ($J$ italicized, reported with up to one digit after the decimal). The number of bonds through which the coupling is operative, $^J$, may be specified by the author if known with a high degree of certainty. $^{13}\text{C}$ NMR signal shifts should be rounded to the nearest 0.01 ppm unless greater precision is needed to distinguish closely spaced signals. Field strength should be noted for each spectrum, not as a comment in the general experimental section. Hydrogen multiplicity ($\text{C}, \text{CH}, \text{CH}_2, \text{CH}_3$) information obtained from routine DEPT spectra should be included. If detailed signal assignments are made, the type of NOESY or COSY methods used to establish atom connectivity and spatial relationships should be identified in the Supporting Information. Copies of spectra should also be included where structure assignments of complex molecules depend heavily on NMR interpretation. Numbering system used for assignments of signals should be given in the Supporting Information with corresponding general structural formula of named derivative.

HPLC/LCMS can be substituted for biochemistry papers where the main focus is not on compound synthesis.

HRMS/elemental analysis. To support the molecular formula assignment, HRMS data accurate within 5 ppm, or combustion elemental analysis [carbon and hydrogen (and nitrogen, if present)] data accurate within 0.5 %, should be reported for new compounds. HRMS data should be given in format as is usually given for combustion analysis: calculated mass for given formula following with observed mass: (+)-ESI-HRMS $m/z$: [molecular formula + H]$^+$ calculated mass, observed mass. Example: (+)-ESI-HRMS $m/z$: calculated for $[\text{C}_{13}\text{H}_{28}\text{BrCl}_3\text{N} + \text{H}]^+$ 327.92899, observed 327.92792.

NOTE: In certain cases, a crystal structure may be an acceptable substitute for HRMS/elemental analysis.

Biomacromolecules. The structures of biomacromolecules may be established by providing evidence about sequence and structure assignments of templates in enzyme-mediated syntheses, or through standard sequencing techniques. Typically, a sequence will be accompanied by MS data that establish the molecular weight.

Example: Product was isolated upon column chromatography (dry flash (SiO$_2$, eluent EA, EA/MeOH gradient 95/5 → 9/1, EA/MeOH/NaOH gradient 18/0.5/0.5 → 9/1/1, and flash chromatography (Biotage SP1, RP column, eluent MeOH/H$_2$O gradient 75/25 → 95/5, N-H column, eluent EA/Hex Gradient 6/3 → EA). was obtained after flash column chromatography (Biotage SP NH column, eluent hexane/EA 4:6 → 2:6). Yield 968.4 mg (95 %). Colorless foam softens at 96-101 °C. $[\alpha]^{20}_D = -0.163 \, (c = 2.0\times10^{-3} \, \text{g/mL}, \text{CHCl}_3)$, IR (ATR): 3376w, 2949m, 2868w, 2802w, 1731s, 1611w, 1581s, 1528m, 1452m, 1374s, 1331w, 1246s, 1171m, 1063w, 1023m, 965w, 940w, 881w, 850w, 807w, cm$^{-1}$. $^1\text{H}$ NMR (500 MHz, CDCl$_3$, δ): 8.46 ($1\text{H}, J = 5.4, \text{H}-2'$), 7.89 ($1\text{H}, J = 2.0, \text{H}-8'$), 7.71 ($1\text{H}, J = 8.9, \text{H}-5'$), 7.30 ($1\text{H}, J = 8.8, J_2 = 2.1, \text{H}-6'$), 6.33 ($1\text{H}, J = 5.4, \text{H}-3'$), 6.07 ($1\text{H}, \text{N-Boc, exchangeable with D}_2\text{O}$), 5.06 ($1\text{H}, \text{H}-12$), 4.92-4.88 ($m, 1\text{H}, \text{H}-7$), 4.42 ($bs, H-3$), 3.45 ($s, \text{CH}_3$-$N$, 3.33 ($bs, H-9'$), 3.05-2.95 ($m, 2\text{H}, H-11'$), 2.70-2.43 ($m, 2\text{H}, H-24$) and HN, exchangeable with D$_2$O), 2.07 ($s, \text{CH}_2$-$COO$), 2.04 ($s, \text{CH}_3$-$COO$), 1.42 ($s, 9\text{H}, (\text{CH}_3)_3\text{C-N}(\text{Boc})$), 0.88 ($s, 3\text{H}, \text{CH}_3-10$), 0.79 ($d, 3\text{H}, J = 6.6, \text{CH}_3-20$), 0.68 ($s, 3\text{H}, \text{CH}_3-13$). $^{13}\text{C}$ NMR (125 MHz, CDCl$_3$, δ): 170.34, 170.27, 151.80, 149.92, 148.87, 134.77, 128.36, 125.11, 121.43, 117.29, 99.98, 75.41, 70.82, 50.43, 49.66, 47.60, 47.33, 44.97, 43.30, 41.83, 41.48, 37.65, 36.35, 35.44, 34.89, 34.19, 33.23, 31.24, 28.79, 28.35, 27.25, 26.45, 25.45, 22.74, 22.63, 21.57, 21.31, 17.85, 12.15. (+)-ESI-HRMS (m/z): calculated for $[\text{C}_{13}\text{H}_{28}\text{BrCl}_3\text{N} + \text{H}]^+$ 795.48219, observed 795.48185. Combustion analysis for $\text{C}_{45}\text{H}_{78}\text{ClN}_9\text{O}_6$: Calculated C 67.94, H 8.49, N 7.04; found C 67.72, H 8.63, N 6.75. HPLC purity: method A: RT 1.994, area 99.12 %; method C: RT 9.936, area 98.20 %.

Purity

Evidence for documentation purpore purity should include one or more of the following:

1. Well-resolved high field $^1\text{H}$ NMR spectrum showing at most only trace peaks not attributable to the assigned structure and a standard $^1\text{H}$ proton-decoupled $^{13}\text{C}$ NMR spectrum. Copies of the spectra should be included as figures in the Supporting Information.

2. Quantitative gas chromatographic analytical data for distilled or vacuum-transferred samples, or quantitative HPLC analytical data for materials isolated by chromatography or separation from a solid support. HPLC analyses should be performed in two diverse systems. The stationary phase, solvents (HPLC), detector type, and percentage of total chromatogram integration should be reported; a copy of the chromatograms may be included as a figure in the Supporting Information.

3. Electrophoretic analytical data obtained under conditions that permit observing impurities present at the 5 % level. HRMS data may be used to support a molecular formula assignment but cannot be used as a criterion of purity.
4. Biological Data
Quantitative biological data are required for all tested compounds. Biological test methods must be referenced or described in sufficient detail to permit the experiments to be repeated by others. Detailed descriptions of biological methods should be placed in the experimental section. Standard compounds or established drugs should be tested in the same system for comparison. Data may be presented as numerical expressions or in graphical form; biological data for extensive series of compounds should be presented in tabular form. Tables consisting primarily of negative data will not usually be accepted; however, for purposes of documentation they may be submitted as supporting information.

Active compounds obtained from combinatorial syntheses should be resynthesized and retested to verify that the biology conforms to the initial observation.

Statistical limits (statistical significance) for the biological data are usually required. If statistical limits cannot be provided, the number of determinations and some indication of the variability and reliability of the results should be given. References to statistical methods of calculation should be included. Doses and concentrations should be expressed as molar quantities (e.g., mol/kg, μmol/kg, M, mM). The routes of administration of test compounds and vehicles used should be indicated, and any salt forms used (hydrochlorides, sulfates, etc.) should be noted. The physical state of the compound dosed (crystalline, amorphous; solution, suspension) and the formulation for dosing (micronized, jet-milled, nanoparticles) should be indicated. For those compounds found to be inactive, the highest concentration (in vitro) or dose level (in vivo) tested should be indicated.

Deposition of crystallographic data
Prior to submission, the crystallographic data included in a manuscript presenting such data should be deposited (together with associated structure factors) at the appropriate database. Crystallographic data associated with organic, metal-organic and inorganic structures should be deposited at the Cambridge Crystallographic Data Centre (CCDC) and FIZ Karlsruhe – Leibniz Institute for Information Infrastructure (FIZ Karlsruhe) joint deposition and access services at https://www.ccdc.cam.ac.uk/deposit. A deposition number will then be provided, which should be added to the reference section of the manuscript. Authors are required to validate their CIF and structure factors using the checkCIF service developed by the International Union of Crystallography (IUCr) at https://checkcif.iucr.org/. Validation alerts returned by checkCIF should be resolved where possible before proceeding. A PDF output of the checkCIF report should be attached to the submission to help the referees reviewing the manuscript.

The RESULTS AND DISCUSSION should include concisely presented results and their significance discussed and compared to relevant literature data. The results and discussion may be combined or kept separate.

The inclusion of a CONCLUSION section, which briefly summarizes the principal conclusions, is highly recommended.

NOMENCLATURE is optional but, if the authors wish, a list of employed symbols may be included.

REFERENCES should be numbered sequentially as they appear in the text. Please note that any reference numbers appearing in the Illustrations and/or Tables and corresponding captions must follow the numbering sequence of the paragraph in which they appear for the first time. When cited, the reference number should be superscripted in Font 12, following any punctuation mark. In the reference list, they should be in normal position followed by a full stop. Reference entry must not be formatted using Carriage returns (enter key; → key) or multiple space key. The formatting of references to published work should follow the Journal’s style as follows:


Books: 2. A. B. Surname1, C. D. Surname2, Name of Book, Publisher, City, Year, p. 100-101 (https://doi.org/doi)**

Compilations: 3. A. B. Surname1, C. D. Surname2, , in Name of Compilation, A. B. Editor1, C. D. Editor2, Ed(s)., Publisher, City, Year, p. 100 (https://doi.org/doi)**

Proceedings: 4. A. B. Surname1, C. D. Surname2, in Proceeding of Name of the Conference or Symposium, (Year), Place of the Conference, Country, Title of the Proceeding, Publisher, City, Year, p. or Abstract No. 100

Patents: 5. A. B. Inventor1, C. D. Inventor2, (Holder), Country Code and patent number (registration year)


Abstracts: For non-readily available literature, the Chemical Abstracts reference should be given in square brackets: [C.A. 139/2003 357348t] after the reference

Standards: 7. EN ISO 250: Name of the Standard (Year)

Websites: 8. Title of the website, URL in full (date accessed)

* When citing Journals, the International Library Journal abbreviation is required. Please consult, e.g., http://www.library.ubc.ca/scieng/coden.html

** doi should be replaced by doi number of the Article, for example: http://dx.doi.org/10.2298/JSC161212085B (as active link). If doi do not exist, provide the link to the online version of the publication.
Only the last entry in the reference list should end with a full stop.
We suggest you to use Mendeley, a free reference manager (www.mendeley.com) and J. Serb. Chem. Soc. Citation Style available in the manager (View -> Citation Style -> Get more Styles). Formatted list of references for works cited in each submission must be additionally uploaded (Online Submissions Step 2).
The names of all authors should be given in the list of references; the abbreviation et al. may only be used in the text. The original journal title is to be retained in the case of publications published in any language other than English (please denote the language in parenthesis after the reference). Titles of publications in non-Latin alphabets should be transliterated. Russian references are to be transliterated using the following transcriptions:
ж → zh, ѣ → kh, ѣ → ts, ч → ch, ү → sh, ѷ → shch, ћ → y, џ → ya, э → e, ї → i, ё → ’.

Supplementary material
Authors are encouraged to present the information and results non-essential to the understanding of their paper as SUPPLEMENTARY MATERIAL (can be uploaded in Step 2 of Online Submission). This material may include as a rule, but is not limited to, the presentation of analytical and spectral data demonstrating the identity and purity of synthesized compounds, tables containing raw data on which calculations were based, series of figures where one example would remain in the main text, etc. The Editorial Board retain the right to assign such information and results to the Supplementary material when deemed fit. Supplementary material does not appear in printed form but can be downloaded from the web site of the JSCS.

MANUSCRIPT REVISION
After evaluation of the manuscript by reviewers, the corresponding author will receive notification and reviewers’ reports by an email. The corresponding author should upload the revised manuscript according to the reviewers’ suggestions and detailed answers to the reviewers’ comments within 60 days at the longest. If no communication from the corresponding author is received by this time period, the Manuscript will be considered as withdrawn. To submit the revised manuscript, please go to JSCS OnLine article processing service http://www.shd.org.rs/JSCS/ and login as Author (with your registered username and password).